Floating license system installation for
DeskArtes Expert Series
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Requirements

If you are already running FLEXIm license server for some other application in your network, do not
install the license server for DeskArtes Expert Series on the same machine where the other license
server is already running.

The floating license system is currently supported for DeskArtes Expert Series only on Windows NT
platform.

To install, the user must have administrative rights.

Terminology

The floating license system for DeskArtes Expert Series consists of the parts illustrated in the following
figure.

License server machine

-license manager (Imgrd.exe)
-vendor daemon (dalicd.exe)
-license file (license.dat)

-DA Expert Series
License client License client License client
machine machine machine
-DA Expert Series -DA Expert Series -DA Expert Series
License server machine The machine where the license manager is running.
License client machine A machine where DeskArtes Expert Series is running, but not
the license manager.
License manager The program (Imgrd.exe) controlling the license usage in the
network, with help of vendor daemons.
License file A file containing the list of all available licenses and vendor
daemons.
Vendor daemon The program controlling the licenses for the applications of one

vendor (dalicd.exe for DeskArtes programs).




Installation steps

—_

Select one machine in your network to be the license server machine.

Run DeskArtes Expert Series floating license client installation on other machines in the network.
(See “Floating license client installation” Step 2)

Run DeskArtes Expert Series floating license server installation on the license server machine.
(See “Installing license server components® Step 3)

In the license server machine use the Control Panel FLEXIm tool to get the system ID and other
information needed to get the license.

(See “Getting the license” Step 4)

Send the information to your distributor or to DeskArtes.

When you get the license, install it in the license server machine.

(See “Installing the license” Step 6)

In the license server machine start the license manager from the FLEXIm tool in the Control
Panel.

(See “Starting the license server” Step 7)

Start DeskArtes Expert Series, either View Expert or 3Data Expert.

Floating license client installation (Step 2)

Start a normal DeskArtes Expert Series installation.
In the Setup type dialog, select "Custom" setup type instead of the default "Typical".
From the components list select "Floating license client" - component, in addition to the defaults.

When the installation program asks the name of the license server machine, type in the hostname
of the machine where you have installed (or will install) the floating license server.

You can find the hostname of a computer for example in the properties of the Windows “Network
Neighborhood”.

Floating license server installation

Note: The floating license server installation also automatically installs the client parts of the floating
license system, so that you can run DeskArtes Expert Series on the license server machine too,
without any additional client installation.

Installing license server components (Step 3)

Start normal DeskArtes Expert Series installation.
In Setup type dialog, select "Custom" setup type instead of the default "Typical".

From the components list select "Floating license server" - component, in addition to the defaults.



Getting the license (Step 4)

After the DeskArtes Expert Series installation has finished, start the FLEXIm license manager tool in
the Windows NT Control Panel (Start->Settings->ControlPanel: FLEXIm License manager).
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Select the "Advanced" tab and click the "Diagnostics"-button. From the FlexIm information window
write down the HOSTNAME and the number between the INTERNET and the DISK_SERIAL_NUM
lines.

Select the "Setup" tab and write down the Imgrd.exe path.

Send the information you collected to your distributor or to DeskArtes.



For example:

hostname = albert
ID number = 00104b47a1b5
Lmgrd path = C:\PROGRA~1\DESKAR~1\Imgrd.exe

Note: The on-line help of DeskArtes Expert Series also has clear instructions on how to obtain the
machine ID for a floating license.

Installing the license (Step 6)

When you get the license, insert the license lines in the file "license.dat" in the directory where
DeskArtes Expert Series was installed. The whole path is normally something like
C:\Program Files\DeskArtes Expert Series\license.dat

The license file has to be in plain ASCII text format to be able to be read correctly. You can create and
edit the license file with any ASCII text editor, like Windows NT notepad.

If you received the license via email, the easiest way to insert it to the license file is with Windows NT
clipboard copy/paste commands:

Open at the same time your email reader and the notepad program.

In the email reader open the message containing the license.

In the email reader select the license lines with the mouse.

In the email reader run the "Copy" command from the "Edit" menu.

In the notepad program run the "Paste" command from "Edit" menu.

In the notepad program use "File" menu "Save As" command to save license file as "license.dat"
in the DA Expert Series installation directory.
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Starting the license server (Step 7)

After the license has been installed, start the FLEXIm license manager tool in WinNT Control Panel.
(Start->Settings->ControlPanel: FLEXIm License manager)

In "Control" tab click the "Start" button to start the license manager.

If the message under the “Status” button says “Server Started”, you can go on and try to start
DeskArtes Expert series: View Expert or 3Data Expert.

In case of any problems see the “Troubleshooting the floating license system” section below.

Troubleshooting the floating license system

If there are any problems in installation of the floating license system or running DeskArtes Expert
Series with a floating license, the following tests will help you in isolating and fixing the problem.



Floating license server installation

Environment variables
Check that the following two environment variables are set and have correct values:

DA_LICTYPE flexim
LM_LICENSE_FILE C:\PROGRA~1\DESKAR~1\license.dat

Here the value of LM_LICENSE_FILE has to be the path of the license file in your installation, the one
above is an example. The correct path can be checked also from the FLEXIm license manager tool in
Windows NT Control Panel (Start->Settings->ControlPanel: FLEXIm License manager). The path
should be same as in the "License File" field in the "Setup" tab.

Note: If you don't know how to check/change environment variables in Windows NT,see the "Handling
environment variables in Windows NT" section below.

License manager paths

The paths for the license manager are shown in "Setup" tab of the FLEXIm license manager tool in
Windows NT Control Panel (Start->Settings->ControlPanel: FLEXIm License manager).

The paths here are normally pointing to the DeskArtes Expert series installation directory. The license
manager program (Imgrd.exe) is copied there during the installation and also the license file and log
file are as default put there.

The paths have to be given using so called MS-DOS names of the files and directories, otherwise the
license manager cannot be succesfully started.

The MS-DOS name of a file or directory can be seen by first select it in Windows NT Explorer and
then running the “Properties” command from the “File” menu.

License file

The license file for the DeskArtes Expert Series floating license system is as default read from the
DeskArtes Expert Series installation directory.

The license file is not yet there after installation because at that point the information needed for the
license is not yet known. So when installing the license, the file just has to be created there.

The license file for the floating license system contains three kinds of lines:

1. The SERVER line contains information about the machine where the license manager is
running.

2. The DAEMON line contains information about so called vendor daemon. The vendor daemon is
started by the license manager and it controls the features of one program. The vendor daemon
for DeskArtes Expert Series is called dalicd.exe.

3. The FEATURE lines contain information about features supported in this license.



In the license there are some parts that can be changed also by the user without invalidating the
license:

1. Inthe SERVER line the hostname and the TCP port number can be changed but not the
machine ID number.

2. Inthe DAEMON line the vendor daemon path can be changed. The dalicd vendor daemon
resides as default in the DeskArtes Expert series installation directory, so this path should point
to that directory too. Also this path has to be in the short format for the vendor daemon to start
succesfully. For example if the DeskArtes Expert series installation directory is

“C:\Program Files\DeskArtes Expert Series”
the correct DAEMON line would then be
DAEMON dalicd C:\PROGRA~1\DESKAR~1\dalicd.exe

If other parts of the license are changed, the license will not work correctly.

Lmtools program

There is a tool program called "Imtools.exe" in the DeskArtes Expert Series installation directory. This
program is useful in testing the functionality of the floating license system.

You can start Imtools by double clicking its icon in the DeskArtes Expert Series installation directory.

After starting Imtools, use first the "Search" button to select the current license file from the DeskArtes
Expert Series installation directory.

Then you can use the Imtools commands to get information about the floating license system and also
somewhat control it. The following commands are available:

Checksum - calculates and shows the checksum of the license file.
Diagnostics - shows diagnostics information about the specified feature.
Shutdown - stops the license manager.
Hostid - shows identification information about the server machine.
Reread - forces the license manager to reread the license file.
Status - displays status information about the license system.
Switchr - switches report file for specified feature.
Time - shows various time information.
Version - shows the version number of the FLEXIm system.
Search - allows selection of the current license file.
Save Text - saves text from the Imtools window into a file.
Exit - exits Imtools.

Logfile

The DeskArtes Expert Series floating license system logfile, called FLEXLM.LOG resides as default in
the DeskArtes Expert Series installation directory. The whole path can be checked from the FLEXIm
license manager tool in the Windows NT Control Panel (Start->Settings->ControlPanel: FLEXIm
License manager). The path is shown in the "Log File" field in the "Setup" tab.

The license manager and vendor daemon startup and shutdown, all feature checkouts and checkins,
and other floating license system events are stored in the logfile. Also if an operation fails the license



manager writes its error messages into the logfile. So especially in case of any problems the lodfile
usually contains very useful information.

The lodfile is also a plain ASCII text file and can be easily handled with any text editor.

Client installation

Environment variables

Check that the following two environment variables are set and have correct values:

DA_LICTYPE flexim
LM_LICENSE FILE  1700@licserver

Here "licserver" must be the hostname of the machine where you are running the floating license
server.

Note: If you don't know how to check/change environment variables in Windows NT, see the
"Handling environment variables in Windows NT" section below.

Lmclient program

In DeskArtes Expert Series installation directory there is a tool program called "Imclient.exe", which is
useful in testing the connection to the license server.

You can use the Imclient to test the license connection as follows:

Start Windows NT Command Prompt (Start->Programs->Command Prompt).

Change current directory to the DeskArtes Expert Series installation directory with "cd"
command. For example "cd C:\PROGRA~1\DESKAR~1".

Start Imclient with command "Imclient".

When the program asks the feature to checkout, give a feature found in the license file.

If everything went well, you can then press return to checkin (release) the feature.

Check the license server lodfile to see that the feature checkout and checkin were marked
there. There should be one line for each.
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The license server logdfile is by default in the DeskArtes Expert series installation directory in the
machine where the floating license server is running. The correct path can also be checked with the
FLEXIm license manager tool in Windows NT Control Panel (Start->Settings->ControlPanel: FLEXIm
License manager). The path is shown in the "Log File" field in the "Setup" tab.

If Imclient doesn't manage to checkout the given feature, it gives an error message telling what went
wrong.



Handling environment variables in Windows NT

The environment variable values can be listed and changed in "System Properties" window in
Windows NT Control Panel (Start->Settings->Control Panel: System). From the System Properties
window select "Environment" tab to see the environment variables and their values.

To change a value of a variable do the following:

1. Select the variable from the list so that you can see it in the "Variable" and "Value" fields below.
2. Change the value in the value field.

3. Click "Set" button to update the new value in the list.

4. Click "OK" button to commit the changes.



